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Navigating in Twain's World

Navigating Through Twain's World
There are many ways of navigating through Twain's World. You can view the different 
areas available in Twain's World from the main screen, jump from one topic to 
another from a hot spot, browse through topics that are related to one another, 
retrace your steps backwards (topic by topic), or return to any previously viewed 
topic.



Navigating in Twain's World

Using Links
Topics are linked to one another by means of hot spots. A hot spot can be a word or 
phrase, or a picture or part of a picture. Text hot spots are displayed in green. A 
picture hot spot may have a border around it. You can identify a hot spot by noticing 
the mouse cursor: it changes to a pointing hand when over a hot spot.
For example, point to the Navigating icon in the upper left-hand corner of this topic 
and you will see the cursor change into a hand, as shown below:

If you click on this icon, it will jump to another topic, which in this case, is the 
Navigating in Twain's World menu.
In addition to jumping to other topics, hot spots can bring up popup windows. Popups
are displayed over the main window. To remove the popup, click anywhere outside of 
the popup, or press the ESC key. Click on this hot spot to view a popup window.



Navigating in Twain's World

Jumping from Topic to Topic
The List button displays a popup window containing the topics available under the 
selected area.

To use the list feature to jump to another topic within the area you are located:
1 Choose the List button from the button bar at the top of the main window.
2 Highlight the topic you wish to view.
3 Double-click the selected topic to jump to it.

See Also
Using The Button Bar
Using The Works Icons
Browsing through Multimedia Sequences



Navigating in Twain's World

Browsing Through Works
The works are linked to one another in a browse sequence. This browse feature lets 
you jump from one work to another.

To display the next or previous work:
* Choose the >> button or << button in the button bar.

See Also
Viewing an A-Z List of Works



Navigating in Twain's World

Using The Works Icons
The Works icons allow you to view the topics available under the selected work.

Click an icon from this illustration to find out what action it performs.

See Also
Jumping From Topic to Topic



Displays the previous topic in a browse sequence within the selected work.



Displays the next topic in a browse sequence within the selected work.



Displays a work history of the selected work containing a brief description and general information.



Displays the various multimedia options associated with the selected work.    For more 
information see Using Multimedia Icons



Allows you to participate in a multiple choice quiz and essay questions on the selected 
work.
* Select a multiple choice answer.    The computer will indicate whether or not you are 

correct.
* The essay questions are in red text immediately followed by the answer in blue.



Returns you to the main text screen of the selected work.



Navigating in Twain's World

Returning to the Main Screen
The Home button, on the button bar, returns you to the main screen of Twain's 
World. This screen is like a control panel, from which you can access the different 
features of Twain's World.
* Choose the Home button from any screen in Twain's World to jump to the main 

screen.

See Also
Using the Main Screen Icons
Using The Button Bar



Navigating in Twain's World

Using the Main Screen Icons
The main screen icons allow you to jump to the various areas of Twain's World.

Click an icon from this illustration to find out what action it performs.

See Also
Returning to the Main Screen
GoTo Menu Commands



The Galleries icon jumps to the Galleries palette menu screen.    For more 
information see Jumping to the Galleries Palette Menu, Using Multimedia Icons.



The Find icon jumps to the finding information screen which displays the index, search
and tour functions.    For more information see Finding Information Using the Index, 
Using Full-Text Search, Taking a Multimedia Tour.



The Exit icon exits Twain's World.    For additional information see File Menu 
Commands.



The About This Disc icon displays the Twain's World copyright information and allows 
you to view a slide show overview presentation of Mark Twain's life.



The Complete Works icon displays the categories of works found in Twain's World 
which include fiction, non-fiction and an A-Z List of writings.    From the categories 
screen, you can view lists of works and select a topic to display.    For more information
see Viewing an A-Z List of Works.



The Time Line icon jumps to an iconographic timeline of Mark Twain's Life.    Click on
the hot spots to view specific time periods and popup presentations.



Navigating in Twain's World

Jumping to the Galleries Palette Menu
The Galleries button jumps to the Galleries palette menu screen.

To view a complete inventory of multimedia topics:
1 Choose the Galleries button from the button bar at the top of the screen.
2 Choose one of the multimedia icons to view a browse sequence of the 

available topics.

See Also
Using Multimedia Icons
Browsing through Multimedia Sequences



Navigating in Twain's World

Viewing an A-Z List of Works
The Works button allows you to view an alphabetical list of all available titles in 
Twain's World.

To view a work:
1 Choose the Works button from the button bar to display a popup window 

containing an alphabetical list of all available works in Twain's World.
2 Highlight the work you wish to view.
3 Double-click on the selected work to jump to it.

See Also
Jumping from Topic to Topic
Using The Works Icons



Navigating in Twain's World

Returning to the Last Topic Viewed
Using the Back button, lets you retrace your steps. In this way, you can step 
backwards through the topics viewed.

To backtrack through topics in the order you viewed them:
* Choose the Back button from the button bar at the top of the screen.

If the current topic is the first topic you viewed, the Back button appears dimmed.

See Also
Returning to Any Topic Viewed



Navigating in Twain's World

Returning to Any Topic Viewed
As you view topics, a record is kept of where you have been. The History button 
displays a list of the topics you've viewed, starting with the most recent. Select any 
topic from this list to return to it.

To jump back to a topic using the History button:
1 Choose the History button from the button bar at the top of the screen.

The last 40 topics you have viewed are displayed in the History window.
2 Double-click the topic you want to view.

Use the scroll bar to see topics not visible in the list.
3 The History window remains displayed. You can choose another topic. You can also 

resize or move the History window.
Tip: You may want to arrange the main window and the History window so that they are side by side.

To close the History window:
* Choose Cancel, or double-click the Control menu box. Pressing the ESC key also 

closes the History window.

See Also
Returning to the Last Topic Viewed



        Twain's World Help Contents

Ways to Find Information in   Twain's World  

Taking a Multimedia Tour

Finding Information Using the Index

Using Full-Text Search

Browsing Through the Search Results

Using Search Operators
Using Multiple Search Operators



Finding Information

Ways to Find Information In Twain's World
To find information in Twain's World, you can use the following techniques:
- View a tour of the Galleries area
- Choose topics from a keyword index
- Perform full-text searches for topic text
Using the Tour button, you can sit back and relax while the computer automatically 
displays the multimedia topics containing the searched text.
Using the Index button, you can search on a keyword or words. When the keyword is 
found, the topic or a list of topics containing the keyword is displayed,.
Using the Search button, you can search on any word or words in the topics. The 
Search feature not only takes you to the topic found, but highlights the word or words 
found by the search. You can use search operators such as AND, OR, NOT, THRU, and 
NEAR to further narrow your search.

See Also
Taking a Multimedia Tour
Finding Information Using the Index
Using Full-Text Search



Finding Information

Taking a Multimedia Tour
The Tour button allows you to search for text within the Galleries area.    The computer
takes you on a tour through the multimedia topics by automatically advancing from 
one appearance of the searched text to the next.    You can use search operators to 
further define the tour.

To perform a multimedia tour:
1 Choose the Tour button from the button bar at the top of the screen.
2 Type text to search or choose a previous search from the pull-down list then click 

the OK Button
3 Adjust the speed with which the tour will proceed.
4 Select a small, medium or large tour.
5 Choose the Begin Tour button to start the tour.
6 You can pause the tour in the following ways:

* Choose the Pause button.
* Click outside of the tour control window.
* Minimize the tour control dialog box to an icon by clicking the down arrow 

in the upper right corner of the window.
* While the tour is paused, you are able perform other functions and 

move around Twain's World.
7 To resume the tour, choose the Resume button.

* If necessary, maximize the tour control window, by clicking on the icon and 
choosing Restore.

8 Press the End Tour button to stop the tour and return to the main window.
Tip:    You can choose the Help button in the tour control dialog box for a quick reminder on how to use the tour
function.

See Also
Using Search Operators



Finding Information

Using Full-Text Search

To search for topics that contain a certain word or phrase:
1 Choose the Search button from the button bar at the top of the screen.
2 In the Search by Word box, type a search query indicating what text you are 

searching for.
To enter a search query that you've searched on previously, select the search query
from the drop-down list box.

3 Under Search In, select All Topics, Selected Topic Groups or Current Topic Only.
* If you chose Selected Topic Groups, select the groups you want to search from 

the Topic Groups list box.
* To search only the topic titles, choose the Options button and select this 

option, then choose the OK button.
4 Choose OK.

A list of the title of each topic containing a search hit in the Search Results 
dialog box is displayed.

See Also
Browsing Through the Search Results
Using Search Operators



Finding Information

Browsing Through the Search Results
When you choose the OK button to search for information, a list of the topics that 
contain search hits in the Search Results dialog box are displayed.

To view a topic in the list:
* Double-click the title.

Use the scroll bar to see titles not visible in the list.
or

* Use the Search Results buttons to move through topics.
To view Do this
Selected topic Choose the Go To button or 

double-click the topic.
Search dialog box Choose the To Search button.
Next search hit in 
the current topic

Choose the Next Match button.

Previous search hit 
in the current topic

Choose the Previous Match 
button.

When you view a topic with search hits, the search hits in that topic are highlighted . If
you minimize the Search Results window, highlighting turns off until you maximize the
Search Results window again.

To close the Search Results window:
* Choose the Cancel button in the Search Results window.
For your convenience, the Search Results window appears on top of the main window. 
You can resize it, move it, or you can minimize it to an icon and then restore it later 
when you need it.

See Also
Using Full-Text Search
Using Search Operators



Finding Information

Using Search Operators
When you use the Search button to search for information, you can use the search 
operators AND, OR, NOT, and NEAR to narrow your search. Each operator is described 
below. You can enter an operator in either lowercase or uppercase letters ("and" is 
interpreted the same as "AND").
AND
The AND operator selects topics containing all phrases connected by AND operators. If
a phrase does not appear in quotes, any space between words in the phrase is 
assumed to represent an implicit AND. For example:
Bees love Honey
This phrase finds any topic containing the three words "Bees," "love," and "Honey." 
This is the same as specifying Bees AND love AND Honey. However, when quotes are 
used, the entire phrase is searched. For example:
"Bees love Honey"
This phrase finds any topic containing the phrase "Bees love Honey."
OR
The OR operator selects topics containing either phrase connected by OR operators. 
For example:
Bees OR Honey
This query displays topics containing either the word "Bees" or the word "Honey."
NOT
The NOT operator selects any topic that does contain the phrase preceding NOT, but 
doesn't contain the phrase following NOT. For example:
Bees NOT Honey
This query finds topics containing the word "Bees" but not the word "Honey."
NEAR
The NEAR operator selects any topic in which one phrase appears within a certain 
number of words of the second phrase. The default value is 8 words. For example:
Bees NEAR Honey
This query finds any topic in which the word "Bees" appears within 8 words before or 
after the word "Honey."
To change the default value, choose the Options button in the Search dialog box and
enter a new number in the NEAR Means Within box. Words that are next to each other 
are within one word of each other.
Tip:    You can choose the Hints button in the Search dialog box for a quick reminder on how to use search 
operators.

See Also



Using Full-Text Search
Using Multiple Search Operators



Finding Information

Using Multiple Search Operators
When you use the Search button to search for information, you can use multiple 
search operators to define more complex search criteria. For example, if you enter 
honey AND bees NOT hives in the Search by Word box, the search will match 
topics that contain the words "honey" and "bees" but do not contain the word 
"hives."
By default, operators are evaluated from left to right. You can use parentheses to 
specify a different order--operators within parentheses are evaluated first.

This query Searches for
honey OR bees AND hives Topics containing either the word honey or 

the word bees in addition to the word 
hives.

honey OR (bees AND hives) Topics containing the word bees and the 
word hives or topics containing the word 
honey.

honey OR bees NOT hives Topics containing either the word honey or 
the word bees but not the word hives.

honey OR (bees NOT hives) Topics containing the word bees but not 
the word hives or topics containing the 
word honey.

Tip:    You can choose the Hints button in the Search dialog box for a quick reminder on how to use search 
operators.

See Also
Using Full-Text Search
Using Search Operators
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Printing and Copying

Printing and Copying Information
You may want to use information in Twain's World in other applications, such as word 
processors. You can copy text and graphics onto the Windows Clipboard. From the 
Clipboard, you can paste the information into any Windows application. You can also 
print out topics, and change printers from within Twain's World.

See Also
Object Linking and Embedding
Copying Topic Text
Printing Topics



Printing and Copying

Changing Printers and Printer Options
Topics are printed on the default printer. If you have installed more than one printer 
in Windows, you can make any of your installed printers the default printer. You can 
also change the default printer options.

To change printers:
1 From the File menu, choose Print Setup.
2 Select Specific Printer.
3 Select the printer that you want to change to, from the drop down list box.

If this file is not in the list box, switch to the Control Panel, select Printers, and 
activate the printer you want to use. Then switch back to Twain's World.

4 Choose OK to close the Print Setup dialog box.

To change printer options:
1 From the File menu, choose Print Setup.
2 Choose the Options button to change the default printer options.

The options available depend on the type of printer you have selected.
3 Choose the options you want, and then choose OK.
4 Choose the OK button to close the Print Setup dialog box.

To change printer orientation, paper size, or source:
1 From the File menu, choose Print Setup.
2 Select Portrait or Landscape for the orientation.
3 Select the paper size you want from the drop down list box.
4 Select the paper source you want from the drop down list box.
5 Choose OK to close the Print Setup dialog box.
For more information on setting up printers, see your Windows documentation.

See Also
Printing Topics



Printing and Copying

Printing Topics

To print an entire topic:
1 Display the topic.
2 From the File menu, choose Print Topic.

To print part of a topic:
1 Display the topic.
2 From the Edit menu, choose Copy.
3 In the Copy dialog box, select the text you want to print, and then choose the Copy 

button.
4 Paste the text into a word processing application.
5 Use the Print command on the application's File menu to print the text.

See Also
Copying Topic Text



Printing and Copying

Copying Topic Text

To copy text to the Clipboard:
1 Display the topic that contains the text you want to copy.
2 From the Edit menu, choose Copy.
3 Select the text you want to copy in the Copy dialog box.
4 Choose the Copy button.
To paste the Clipboard contents into another document, use the Paste command from 
the application's Edit menu.

See Also
Object Linking and Embedding



Printing and Copying

Object Linking and Embedding
The information in Twain's World can be copied into other applications with Object 
Linking and Embedding (OLE) capabilities.
Two types of documents are used to perform OLE functions.    The source or server 
document such as drawing software contains the original object.    The object is then 
copied into the destination or client document such as a word processor.
For detailed instructions on performing this function and to determine whether the 
application you are using is OLE compatible, refer to your Windows and other software
documentation.

To copy objects from Twain's World to other applications, press the Print Screen key. 
The entire screen will be copied.

See Also
Copying Topic Text
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Bookmarks and Annotations

Annotating Twain's World
The Bookmark and Annotation features allow you to save information in reference to 
specific topics. A bookmark is simply that: a marker which "saves your place" in 
Twain's World. Like any book, you can have many bookmarks in Twain's World. When 
the bookmark is selected, you jump directly to that topic.
Annotations are simply notes or comments "paper clipped" to a topic. It's the same as
paper clipping a note to a page in a book. You can copy and paste text in annotations.

See Also
Using Bookmarks
Annotating a Topic



Bookmarks and Annotations

Using Bookmarks
Just as you can place bookmarks in a printed book to mark specific references, you 
can place bookmarks at the topics you view frequently. Once you have placed a 
bookmark at a topic, you can quickly display that topic from the Bookmark menu.

To insert a bookmark:
1 Display the topic at which you want to place a bookmark.
2 From the Bookmark menu, choose Define.
3 The topic title is proposed as the bookmark name. If you want to change the 

name, type a new name in the Bookmark Name box.
4 Choose OK.

The bookmark name appears on the Bookmark menu.

To remove a bookmark:
1 From the Bookmark menu, choose Define.
2 Select the bookmark you want to remove.
3 Choose Delete.
4 Choose OK.

See Also
Jumping to a Bookmark



Bookmarks and Annotations

Jumping to a Bookmark
After you've inserted bookmarks, you can go directly to them at any time.

To go to a marked topic:
* From the Bookmark menu, choose the topic you want to view.

Underlined numbers precede the first nine bookmark titles. You can press the 
corresponding number key or choose the bookmark title to go quickly to a marked 
topic.
If more than nine bookmarks have been defined, choose More from the Bookmark 
menu. Select a bookmark, and then choose the Go To button.

See Also
Using Bookmarks



Bookmarks and Annotations

Annotating a Topic
You can attach your own comments to a topic. When you annotate a topic, a paper 
clip icon is placed to the left of the topic heading. The paper clip icon reminds you that
you have attached text to this topic.

To attach text to the current topic:
1 From the Edit menu, choose Annotate.
2 Type the text in the Annotation edit box.

If you make a mistake, press Backspace or the Delete key to erase any unwanted 
characters and then continue typing.

3 Choose OK when you have finished the annotation.

To remove an annotation:
1 Display the topic where you made the annotation.
2 Click the paper clip icon.
3 Choose the Delete button.

See Also
Viewing an Annotation



Bookmarks and Annotations

Viewing an Annotation

To view an annotation:
1 Display the topic where you made the annotation.
2 Click the paper clip icon.
3 Choose the Save or Cancel button when you have finished reading the annotation.
Tip:    Place a bookmark at an annotation to return to it quickly.

See Also
Copying and Pasting Annotations
Using Bookmarks



Bookmarks and Annotations

Copying and Pasting Annotations
You can copy text from an annotation to the Clipboard or paste text from the 
Clipboard into an annotation.

To copy text from an annotation to the Clipboard:
1 Display the topic where you made the annotation.
2 Click the paper clip icon.
3 If you want to copy all of the annotation, choose the Copy button.

If you want to copy only a portion of the annotation, select the text in the Annotate 
edit box, and then choose the Copy button.

To paste text from the Clipboard into an annotation:
1 Display the topic where you made the annotation.
2 Click the paper clip icon.
3 Position the insertion point where you want to paste the text.

To position the insertion point, point and click the mouse or press the arrow keys.
4 Choose the Paste button.

If any text is selected when you choose the Paste button, it is replaced by the new 
text.

See Also
Copying Topic Text
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Buttons and Menus

File Menu Commands
The File menu contains these commands:

- Open
- Print Topic
- Print Setup
- Exit

Scroll down to see descriptions of each command.
Open
Displays a dialog box in which you can select and open a title.
Print Topic
Prints the displayed topic (assuming you have a printer installed and turned on).
Print Setup
Displays a dialog box in which you can change printer settings before printing.
Exit
Closes Twain's World.

See Also
Changing Printers and Printer Options
Printing Topics



Buttons and Menus

Edit Menu Commands
The Edit menu contains these commands:

- Copy
- Annotate

Copy
Places a copy of the displayed topic in a dialog box, where you can select text to copy 
to the Clipboard.
Annotate
Displays a dialog box in which you can attach your own notes to the current topic.

See Also
Copying Topic Text
Annotating a Topic



Buttons and Menus

Bookmark Menu Commands
The Bookmark menu contains these commands:

- Define
- More

Scroll down to see descriptions of each command.
Define
Displays a dialog box in which you can add a bookmark to the current topic or delete
an existing bookmark.
More
This command appears only when more than nine bookmarks have been added to the
Bookmark menu. Displays a dialog box in which you can select a bookmark.

See Also
Using Bookmarks
Jumping to a Bookmark



Buttons and Menus

Help Menu Commands
The Help menu contains these commands:

- Help Contents
- About

Help Contents
Displays the Twain's World Help Contents screen. This is the same as pressing F1 
while in Twain's World.
About
Displays a dialog box containing copyright information.



Buttons and Menus

GoTo Menu Commands
The GoTo menu contains these commands:

- Home
- Galleries

Home
Returns    you to the main screen.
Galleries
Jumps to the Galleries palette menu screen.



Buttons and Menus

Using the Button Bar
Use the following buttons to browse and look up information in Twain's World.

Select any button from this illustration to find out what action it performs.



Displays the main screen for Twain's World.    For more information, see Using the Main
Screen Icons.



Displays a popup window containing a table of contents of all available works in 
Twain's World.    For more information, see Viewing an A-Z List of Works, Using the Main 
Screen Icons.



Displays a popup window containing the available topics under the selected area.    
For more information, see Jumping From Topic to Topic, Using The Works Icons, Browsing
through Multimedia Sequences.



Brings you to the Galleries palette menu screen.    For more information, see    
Jumping to the Galleries Palette Menu, Using the Main Screen Icons.



Displays an index of keywords and phrases. You can select a word from the index list, 
and then display a topic that contains information related to that word. For more 
information, see Finding Information Using the Index.



Automatically advances from one appearance of the searched text to the next within 
the Galleries area.    For more information, see Taking a Multimedia Tour.



Backtracks through topics in the order you viewed them. For more information, see 
Returning to the Last Topic Viewed.



Displays a list of the last 40 topics you have viewed. Double-click any topic title to 
redisplay the topic. For more information, see Returning to Any Topic Viewed.



Allows you to search for any combination of words and phrases, and then browse the 
topics that contain search hits. For more information, see Using Full-Text Search.



Displays the previous topic in a browse sequence within the Galleries area only .



Displays the next topic in a browse sequence within the Galleries area only. Clicking 
the >> button is like turning the page in a printed book.



Keyboard Techniques

Using Accelerator Keys
The following is a list of keyboard shortcuts available in Twain's World:
Keys Action
Ctrl+C, Ctrl+Ins Copies the displayed topic 

text to the clipboard
Ctrl+Shift+Alt+
F1

Jumps to the Main screen

Ctrl+Shift+Alt+
F2

Brings up the Index dialog 
box

Ctrl+Shift+Alt+
F3

Takes you to the last topic 
viewed (Back)

Ctrl+Shift+Alt+
F4

Brings up the History list

Ctrl+Shift+Alt+
F5

Displays the previous topic 
in the browse sequence 
within the Galleries area

Ctrl+Shift+Alt+
F6

Displays the next topic in 
the browse sequence 
within the Galleries area

Tab Moves to next hot spot
Shift+Tab Moves to previous hot spot
Ctrl+Tab Highlights all hot spots
Esc Removes the top-most 

popup
Alt Removes all popups
Alt+F4 Exits Twain's World
F1 Help Contents

Press ALT key plus underlined letter of a command word to perform that function.    
(i.e., Alt+W displays the Works table of contents)



Home button

The button that displays the main screen for Twain's World.



Works button

This button displays a table of contents of all available works in Twain's World.



Index button

The button that looks up topics associated with particular words or phrases previously 
defined.



Back button

This button backtracks through topics in the order you viewed them.



History button

Displays a list of the last 40 topics you have viewed.



List button

Displays a window containing the topics available under the selected area.



Galleries button

Brings you to the Galleries palette menu screen.



Tour button

Automatically advances from one appearance of the searched text to the next within the 
multimedia topics only.



>> button

The button that displays the next topic in the current browse sequence within the 
Galleries area.



<< button

The button that displays the previous topic in the current browse sequence within the 
Galleries area.



Search button

The button that searches for all topics containing a particular word or combination of words.



Hints button

In the Search dialog box, the button that shows examples of how to enter search queries.



Next Match button

The button in a list of search hits that displays the next search hit in the current topic not 
currently displayed on the screen.



Previous Match button

The button in a list of search hits that displays the previous search hit in the current topic 
not currently displayed on the screen.



To Index button

The button in the Topics Indexed dialog box that takes you back to the Index dialog box.



To Search button

The button in the Search Results dialog box that takes you back to the Search dialog box.



Options button

The button in the Search dialog box that displays the available search options. The Search 
Options dialog box is where you can change the NEAR value, select topic titles as the search 
domain, or select to search from a list of previous topics found.



Go To button

The button in the Topics Indexed and the Search Results dialog box that displays the 
selected topic from the list.



bookmark
A name associated with a topic for easy reference. Bookmarks appear on the 
Bookmark menu. When you select a bookmark from the menu, the topic associated 
with that bookmark is displayed.



Clipboard
The Microsoft Windows application that holds cut or copied information, which you can
then insert into another file. Whenever you use a Cut, Copy, or Paste command, you 
are using the Clipboard.



main screen
The "control panel" for Twain's World. From this screen, you can select which part of 
the title you want view and what functions you want to perform.



topic
A unit of information containing any combination of text, graphics and multimedia 
options.



Topics Indexed
An index dialog box that lists topics from an index search which allows you to browse 
and go to topics in the list.



Search Results
The dialog box that lists topics containing search hits from a search query and 
allows you to browse and go to topics in the list.



search query 
A combination of words, phrases, and operators which indicate the text to be 
searched.



browse sequence
A sequence of topics arranged so that you view them in succession when you select 
the << or >> buttons.



topic title
A name identifying a topic found by searches from the Index and Search commands.



jump
A hot spot that displays another topic in the main window.



hot spot
A word, phrase, or picture that you select to jump to a new topic or display a popup 
window.



search hit
An occurrence of text in a topic that matches the search query entered for the 
Search command.



current position
The position in an audio or video sequence that is currently being played, indicated by
the thumb in the slider control.



thumb

The pointer in the slider of a controller indicating the current position in the audio or 
video sequence.



slider
The control in an audio or video sequence that contains the thumb, which indicates 
the current position in the audio or video sequence.



Galleries palette menu screen
Allows you to view an inventory of all the multimedia topics available in Twain's 
World.



multimedia
Twain's World incorporates multimedia options including pictures, graphics, 
animations, video, and audio.



popup
Smaller windows which are displayed over the main window when a hot spot is 
selected.    To close popup windows, click outside of the popup region or press the ESC 
key.



multimedia icon
A hot spot which displays pictures, narrations, videos and characters.



Begin Tour button

The button in the tour control dialog box which starts a multimedia topic tour.



Pause button

The button in the tour control dialog box which stops the multimedia tour until the user 
presses the Resume button.



Resume button

The button in the tour control dialog box which continues the paused multimedia tour.



End Tour Button

The button in the tour control dialog box which stops the multimedia tour and closes the 
tour control dialog box.



Object
Any combination of text, audio and graphics to be used as a single unit and copied 
into another application.



Linking
Creates a link between the original object and all copies of the object in other 
software applications.    Changes made to the original or any of its copies will appear 
on all versions of the object.    In order to link an object, it must first be saved as a 
document.



Embedding
Creates a copy of an object from one software application to another.    Once an 
object is embedded, changes can be made to either the original or the copy without 
effecting the other.



iconographic timeline
A time line with pictorial representations created out of hot spots.



Finding Information

Finding Information Using the Index
Using the Index button is like using the index of a book. You can browse through a list 
of keywords, and then jump to a topic by selecting a word from the index.

To look up a topic using the index:
1 Choose the Index button from the button bar.
2 Type the word you want to search for or select the word from the Index list.

You can press a key on your keyboard to move quickly to different parts of the list. 
For example, type "S" to move to words beginning with the letter "S" and then type
"O" to see words beginning with "So."

3 Choose OK.
If only one topic is linked to the word, that topic is displayed.
If there is more than one topic linked to the word, the topics are displayed in the 
Topics Indexed dialog box.
To return to the Index, choose the To Index button.

4 Double-click the topic you want to view, or select the topic and choose the Go To 
button.

See Also
Using Full-Text Search
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Using the Multimedia Controller

Using Multimedia Icons
Browsing through Multimedia Sequences



Multimedia Features

Using the Multimedia Controller
You can play an audio or video sequence using a control panel that appears within a 
topic or that pops up when you select a hot spot. Either type of sequence may 
include the multimedia controller, as shown below:

Select any control from this illustration to find out what action it performs.

To control a sequence that does not have a control panel:
* Click the window while the sequence is playing to stop it.
* Click the window after stopping the sequence to start playing it again.



Stop Button
    Stops playback of the audio or video sequence.



The slider control lets you drag the thumb to move the current position back (left) 
or forward (right) in the audio or video sequence.



Play Button
    Starts playing the presentation.



Pause Button
    Stops playing the presentation until the user presses this button again.



Step Backward/Fast Rewind Button
    When clicked once, steps backwards (by frames or by seconds) in the presentation. 

When clicked and held down, rewinds backwards through the presentation.



Step Forward/Fast Forward Button
    When clicked once, steps forward (by frames or by seconds) in the presentation. When 

clicked and held down, fast forwards through the presentation.



Multimedia Features

Using Multimedia Icons
These icons allow you to view the multimedia topics available in Twain's World.    You 
can access these icons through the Galleries palette menu screen or within the 
Works area.

Select an icon from this illustration to find out what action it performs.

See Also
Using the Multimedia Controller



Displays pictures with short descriptions.



{ewl MVMCI2, ViewerMCI, [device WaveAudio][buttons play pause stop scanl scanr][stepsize
1000][slider][caption 'Hear - A Salutation From The 19th To The 20th Century'][autostart]!
salutatn.wav}
Allows you to listen to author selected narrative clips from works in Twain's World.



{ewl MVMCI2, ViewerMCI, [device AVIVideo][buttons play pause stop scanl scanr]
[stepsize 1000][slider][caption 'Watch - Marching to Battle'][autostart]!prhiscam.avi}
Allows you to view video clips and animations.



Displays characters from Twain's writings.



Multimedia Features

Browsing Through Multimedia Topic Sequences
The multimedia topics are linked to one another in a browse sequence. This browse 
feature lets you scan the topics one by one within the Galleries area.

To display the next or previous multimedia topic:
* Choose the >> button or << button in the button bar.
Tip: If the multimedia topic is the first in the browse sequence, the << button appears dimmed

If the multimedia topic is the last in the browse sequence, the >> button appears dimmed

See Also
Using Links
Jumping From Topic to Topic




